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Troubleshooting Problems

Overview

The X64 Xcelera-CL PX4 (and the X64 family of products) has been tested by DALSA in a variety of
computers. Although unlikely, installation problems may occur due to the constant changing nature of
computer equipment and operating systems. This section describes what the user can verify to determine
the problem or the checks to make before contacting DALSA Technical Support. If you require help and
need to contact DALSA Technical Support, make detailed notes on your mstallation and/or test results for
our technical support to review. See "Technical Support” on page 124 for contact mformation.

Problem Type Summary

X064 Xcelera-CL PX4 problems are either installation types where the board hardware is not recognized
on the PCIe bus (i.e. trained) or function errors due to camera connections or bandwidth issues. The
following links jump to various topics in this troubleshooting section.

First Step: Check the Status LED

A RED Status LED 1 indicates a camera problem, while various Green states indicate the acquisition
mode.

Status LED 2, if flashing RED., indicates a PCIe bus problem. If you run the PCI Diagnostics tool, the
LX1 1s not in the PCI device list. If the board is installed m a computer which supports PCle GEN2
expansion slots, see section "SW3-2 GEN2 Slot Workaround Details" on page 86.

The complete status LED description is available in the technical reference section (see "Status LEDs
Functional Description" on page 87).

Camera to Camera Link Connections
X064 Xcelera-CL PX4 End Bracket

X64 Xcelera-CL PX4

fe==bld==b D

— Camera Link 1 T Camera Link 2
3M MDR 26 pin female LEDs  3M MDR 26 pin female
connector connector
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Possible Installation Problems

Hardware PCI bus conflict: When a new installation produces PCI bus error messages or the board
driver doesn't install. it is important to verify that there are no conflicts with other PCT or system
devices already installed. Use the DALSA PCI Diagnostic tool as described in "Checking for PCI
Bus Conflicts" on page 27. Also verity the installation via the "Driver Information via the Device
Manager Program" on page 30.

Gen?2 slot errors: There is a PCI bus error message from the computer bios. Follow the instructions
"GEN2 PCI Slot Computer Issue" on page 29.

Verify Sapera and Board drivers: If there are errors when running applications, confirm that all
Sapera and board drivers are running. See "Sapera and Hardware Windows Drivers' on page 29 for
details. In addition, DALSA technical support will ask for the log file of messages by DALSA
drivers. Follow the mstructions describe in "DALSA Log Viewer" on page 31.

Firmware update error: There was an error during the board firmware update procedure. This
usually is easily corrected by the user. Follow the instructions "Recovering from a Firmware Update
Error" on page 29.

Installation went well but the board doesn't work or stopped working. Review theses steps described
m "Symptoms: CamExpert Detects no Boards" on page 32.

Possible Functional Problems

Driver Information: Use the DALSA device manager program to view information about the
mstalled X64 Xcelera-CL PX4 board and driver. See "Driver Information via the Device Manager
Program" on page 30.

Sometimes the problem symptoms are not the result of an installation issue but due to other system
1ssues. Review the sections described below for solutions to various X64 Xcelera-CL PX4 functional
problems.

"Symptoms: X64 Xcelera-CL PX4 Does Not Grab" on page 33
"Symptoms: Card grabs black" on page 33

"Symptoms: Card acquisition bandwidth is less than expected” on page 34

M—Rro Y a—F1 9D 5



Teledyne DALSA EREGAR— F 20124 10 A 1 H

AEEEDH DA VX F—/LIERE)
DIN—=FED 77 PCI/NADEZR :
FUWA YA R=)ILTPCINRIS— X —INDRELZD, TER—FRSANDA YR E=I
SNZNER. BRICH YR E=ILSNEZYRFTAT/INA RZ 21D PCI THZIENENSZE
EmIDEIFBEETCY,
“Checking for PCI Bus Conflicts” Cind DALSA PCI Diagnostics tool Z{HR L& T,
Fie. TNARAIVR=I v —aRBRBLUTT/NA RABREZHLU T Y X F—)UIRREZRRLE T,

@Gen2 slot TS —:
JOVEaA—FBIOSHS PCINRIS—XvE—INHNFET, MUKIC “GEN2 PCI ZOw k-
Va2 —-SYREEERUET,

@BSapera Eh— R RS /NOWER -
PTIT =3 UHQRITHIS—HEDIRE. EITPOETD Sapera Ev— R RSANEERLUET,
E¥#B(3 “Sapera and Hardware Windows Drivers P29" =S 88REVE T,

@I P—LDTP Py IF—kF IS5
M=RIP—=ADIDP« PyIT—FUBEZRGTD, IS5-HEDBE. CNE@F. 1-Y-7T
ESE(CIZEIEN'TBETY, F52IC “Recovering from a Firmware Update Error P29”[CRLE T,
(X64 Xcelera-CL PX4 1—HY =XV _aPILEEICERLTRNET.)

aJEEMEDH DIEEERTRE)
BERANDS . 1 V2 +—)UENTE X64 Xcelera—CL PX4 h— RERIE RS /NICTDNT
ISIREENDDIZHIC DALSA T/INA R « ¥R—I v —TJOTSAEFARLFET,

M—Rro Y a—F1 9D 6



Teledyne DALSA

EREGAR— K

20124 10A 1 H

Troubleshooting Procedures

The following sections provide information and solutions to possible X64 Xcelera-CL PX4 installation
and functional problems. These topics are summanzed 1n the previous section of this manual

Checking for PCI Bus Conflicts

One of the first items to check when there 1s a problem with any PCI board 1s to examine the system PCI
configuration and ensure that there are no conflicts with other PCT or system devices. The Teledyne
DALSA PCT Diagnostic program (cpcidiag.exe) allows exanunation of the PCI configuration registers
and can save this information to a text file. Run the program via the Windows Start Menu shortcut Start «
All Programs » Teledvne DATSA « Sapera LT = Tools « PCI Diagnostics.

As shown m the following screen image, use the first drop menu to select the PCI device to examine.
Select the device from Teledyne DALSA. Note the bus and slot number of the installed board (this will

be unique for each system unless systems are setup identically). Click on the Diagnostic button to view
an analysis of the system PCI configuration space.
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Clicking on the Diagnostic button opens a new window with the diagnostic report. From the PCI Bus
Number drop menu select the bus number that the X564 Xcelera-CL PX4 is installed in—in this example
the slot 1s bus 2.

The window now shows the I/O and memory ranges used by each device on the selected PCI bus. The
information display box will detail any PCI conflicts. If there 1s a problem. click on the Save button. A
file named “pcidiag.txt’® 1s created (in the Sapera‘bin directory) with a dump of the PCI configuration

PCI /N R EZEDHEER)

20 PCI N— RICEEN D DIBSICHRICHERITDIEBED 1 DIE. YRXFTADPCI Z/NBDCETY, IV I+«

FaU—Y3avEMD PClI FERYRTADTNA ZEDFHESHNRNCEZERLTET,

PCI 2217003 A

(cpcidiag.exe) 3. PCI OV +FaUL—Y3VDUIRAIBENTEET. CNETFIAFT 71 ILDEHRE LT

REIDCENTEIET,

MR oINS d—g 1 I
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registers. Email this file when requested by the DALSA Technical Support group along with a full
description of your computer.

[ Diagnostic |AJ1

- PLI bus 1/0 range
Number

fnz ]

Range

170; 000000000 000000000
Mern: Oxd7100000-Df T Karor,1enge
Pref- 0x00000000/0000000-0x000000C || 00000000FO000000-0000000CAO3Ti DALSA (2. 0. 0]

Information
Mo conflict in PCI configuration for bus 2.

4 m [

I™ Display wamings Save (1] 4

MR oINS d—g 1 I 3
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Displaying X64 Xcelera-CL PX4 Board

Information

The Device Manager program also displays information about the X64 Xcelera-CL PX4 boards mstalled
in the system. To view board information run the program via the Windows Start Menu shortcut Start «
Programs * Teledyne DATSA » X64 Xcelera-CL PX4 Device Driver » Device Manager.

Device Manager — Board Viewer

The following screen image shows the Device Manager program with the Information/Firmware tab
active. The left window displays all X64 Xcelera-CL PX4 boards i the system and their individual
device components. The nght window displays the information stored in the selected board device. This
example screen shows the X64 Xcelera-CL PX4 information contained in the EEProm component.

The X64 Xcelera-CL PX4 device manager report file (BoardInfo txt) 15 generated by clicking File » Save
Device Info. This report file may be requested by Teledyne DALSA Technical Support to aid in

troubleshooting installation or operational problems.
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GEN2 PCI Slot Computer Issue

At boot time, the PX4 status LED 2 keeps on flashing red. If you run the PCI Diagnostics tool. the PX4 15
not in the PCI device list. If the board 1s installed in a computer which supports PCle GEN2 expansion
slots. see section "SW3-2 GEN2 Slot Workaround Details" on page 86.

BSOD (blue screen) Following a Board Reset

Teledyne DALSA engineering has identified cases where a PC will falsely report a hardware malfunction
when the X64 Xcelera-CL PX4 board 1s reset. The symptoms will be a Windows blue screen or PC that
freezes following a board reset. The solution to this problem 1s to install the driver using the switch “/er”,
indicating to the driver that a reset of the board must not be allowed and that a reboot of the computer 1s
needed instead.

=  Example: X64 Xcelera-CL_PX4 1.00.00.0000.exe /cr

Sapera and Hardware Windows Drivers

The next step is to make certain the appropriate Teledvne DATSA drivers have started successfully
during the boot sequence. Example. click on the Start « Programs » Accessories * System Tools »
System Information * Software Environment. Click on System Drivers. Make certain the following
drnivers have started for the X64 Xcelera-CL PX4.

Device Description Type Started
CorX64Expredx K64 Heelera-CL PX4 messaging Kernel Driver Yes
CorLog Sapera Log viewer Eernel Driver Yes
CotMem Sapera Memory manager Kernel Driver Yes
CorPci Sapera PCI configuration Kernel Driver YTes
CorSerial Sapera Senial Port manager Kermel Driver Yes

Teledyne DALSA Technical Support may request that you check the status of these drivers as part of the
troubleshooting process.

Recovering from a Firmware Update Error

This procedure 15 required if anv failure occurred while updating the X64 Xcelera-CL PX4 firmware on
installation or duning a manual firmware upgrade. On the rare occasion the board has corrupted firmware,
any Sapera application such as CamExpert or the grab demo program will not find an installed board to
control.
Possible reasons for firmware loading errors or corruption are:

+  Computer system mains power failure or deep brown-out.

e  PCI bus or checksum errors.

MR oINS d—g 1 I 10
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*  PCI bus iimeout conditions due to other devices.
*  User forcing a partial firmmware upload using an mnvalid firmware source file.
When the X64 Xcelera-CL PX4 firmware 15 corrupted. executing a manual firmware upload will not

work because the firmware loader can not communicate with the board. In an extreme case, corrupted
firmware may even prevent Windows from booting.

Solution: The user manually forces the board to wnitialize from write protecied firmware designed only to
allow driver firmware uploads. When the fimnware upload 1s complete. the board 1s then rebooted to
initialize in 1ts normal operational mode.

s  Note that this procedure may require removing the X64 Xcelera-CL PX4 board several times
from the computer.

*  Tmportani: Refernng to the board's user manual (in the connectors and jumpers reference
section). identify the configuration switch location. The Boot Recovery Mode swiich for the X64
Kcelera-CL PX4 15 SW3-1 (see "SW3: " on page 86).

Shut down Windows and power OFF the computer.

+ NJove the switch SW3-1 to ON. for the boot recovery mode position. (The default position 1s
SW3-1 to OFF for normal operation).

+  Power on the computer. Windows will boot normally.

+  When Windows has started. do a manual firmware update procedure to update the firmware
agaimn (see "Finmware Update: Manual Mode" on page 13).

s+  When the update 1s complete, shut down Windows and power off the computer.

+  Setthe SW3-1 switch back to the OFF position (1.e. default position) and power on the computer
Once again.

+  Verify that the frame grabber 15 functioning by munmng a Sapera application such as CamExpert.
The Sapera application will now be able to communicate with the X64 Xcelera-CL PX4 board.

Driver Information via the Device Manager Program

The Teledyne DALSA Device Manager program provides a convenient method of collecting information
about the installed X64 Xcelera-CL PX4. System information such as operating system. computer CPU.
system memory. PCI configuration space. plus X64 Xcelera-CL PX4 firmware information can be
displayed or written to a text file (default file name — BoardInfo txt). Note that this 1s a second function
mode of the same program used to manuvally upload firmware to the X64 Xcelera-CL PX4.

Execute the program via the Windows Start Menu shortcut Start » All Programs » Teledyne DALSA »
X064 Xcelera-CL PX4 Device Driver * Device Manager. If the Device Manager program does not run. 1t
will exit with a message that the board was not found. Since the 64 Xcelera-CL PX4 board must have
been in the system to install the board driver. possible reasons for an error are:

+ Board was removed
+ Board driver did not start or was terminated
+  PCI conflict after some other device was mstalled

MR oINS d—g 1 I 12
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Information Window

The following figure shows the Device Manager mnformation screen. Click to highlight one of the board
components and the information for that ttem 1s shown on the nght hand window. as described below.
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+ Select Information to display identification and information stored 1n the X64 Xcelera-CL PX4
firmware.

*  Select Firmware to display version information for the firmware components.

=  Select one of the firmware components to load custom firmvware when supplied by Teledvne
DALSA engmeering for a future feature.

#  (Click on File » Save Device Info to save all information to a text file. Email this file when
requested by Technical Support.

Teledyne DALSA Log Viewer

A step in the verification process is to save 1n a text file the information collected by the Log Viewer
program. Run the program via the Windows Start Menu shortcut Start « All Programs * Teledyne
DATLSA » Sapera LT » Tools « Log Viewer.

The Log Viewer lists information about the mstalled board drivers. Click on File » Save and vou will be
prompted for a text file name to save the Log Viewer contents. Email this text file to Teledyne DATLSA
Technical Support when requested or as part of vour initial contact email.

DALSA Log Viewer

ENIE
25— -0 /A—DALSA—SperalLT—Tools—Log Viewer =) w2 LE#) LE T,

Log Viewer Zi28) U CESENE T —45 &1t 58 GEYBELE T,
C @ Log Viewer [FX—71— (DALSA) TEHTEE U TEREINIZ Tool TY,
MNFELT, CORBRIA—N—DOBEEOHERIDENTEZET,
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On-board Image Memory Requirements for Acquisitions

The X64 Xcelera-CL PX4 allocates by default two frame buffers in on-board memory, each equal in size
to the acquisition frame buffer. This double buffering memory allocation is automatic at the drver level
Two buffers will ensure that the acquired video frame is complete and not corrupted in cases where the
image transfer to host system memory may be interrupted and delayed by other host system processes.
That 1s. the image acquisition to one frame buffer 1s not interrupted by any delays in transfer of the other
frame buffer (which contains the previously acquired video frame) to system memory. Note that an
application can change the number of on-board frame buffers using the Sapera LT APL If allocation for
the requested number of buffers fails. the driver will reduce the number of on-board frame buffers
requested until they can all fit. When reaching 2 on-board buffers, if they still cannot fit, the driver will
reduce the size such that it allocates two partial buffers. This mode will write image data to the buffer
while wrapping image lines around to the beginning of a buffer when full. This mode relies on reading
out the image data to the host computer faster than the acquisition.

Symptoms: CamExpert Detects no Boards

o [Ifusing Sapera version 6.00 or later:
When starting CamExpert. if no Teledyne DALSA board 15 detected. CamExpert will start in
offline mode. There is no error message and CamExpert is functional for creating or modifying a
camera configuration file. If CamExpert should have detected the installed board. troubleshoot
the mstallation problem as described below.

Troubleshooting Procedure
When CamExpert detects no installed board. there could be a hardware problem. a PnP problem. a PCI
problem, a kernel driver problem. or a software installation problem.
+  Make certamn that the card 1s properly seated i PCle slot.
*  Perform all installation checks described i this section before contacting Technical Support.
*  Try the board in a different PClIe slot if available

MR oINS d—g 1 I 15
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TYTP7RAFXXYAASTREESND A E)

X64 Xcelera-CL PX4 (&, JU—ANy I PZERBIDEHDY 1 XT, ZNZNELNTYM—F
XEUCHBI2DDIU—LNYITPEEDHETET, COFTINNY I P AEJEIDHETIE, RS1/NUANIL
TEINICEIDHETENE T, X64 Xcelera-CLPX4 RS /NE1 X —=IDNRA YT AXEITEIDAFND
ROBEEEMDNR S RAFT ABOFITRESNEN, EFATU—LZEIRT DD
[C2DDONY I PZEFERALET., 1 DDIU—LNY T PADA XA —=IIBIEIYIFTAXEIAD
FICIRBESNEZEETAIU—LAZESE) DI L —A/Ny T 7 DEEDLE DD DENICKDEHAHD
ENEDLFIRETY,

2DDAID—=FIV s TU—L - NI 2D E—=F)I Y1 XIBEGEIEEERICHNEESIND
XEUZA—=IN=AY FED—=FIDAVIR—EXEUT A ZRDEDDDRL URITNEZRDEE A
X64 Xcelera-CLPX4 D2 DDTIU—LNY I P EXE) « TS5— « XwE—IDEHDO+HS
ZIUM—EREOXEUHENIBE. [Error : “CorXferConnect” <Xfer Module>- No memory() ] 1Y
Sapera DARXS T 71 IVEGFOR., EPTIT =y 3N I U—A - Ny D P EEKT DFIC
BELFET,

SIS a—TFTa2y
CamExpert D1 VX ~—)LENTZ PC D DALSA Mh— REEE URNE. N—ROITP0
RIREE/C(E. PnP ORIRE. PCI DRIE. N—RILESA/I\ORIBED, VI I P+ VA=)
DREIBENBZ5NFT,

« N—RNDPCle RO Y FTEUICENNTNDDE DDENDE T,

 TOZNILTR— bNEB T DRIC, COEIYIVTRESNCETCDI YRR —Y3VYDFIVvI%E
T LI,

+ D PCle 20V ~FCHATRERSMN— FERLET,
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Symptoms: X064 Xcelera-CL PX4 Does Not Grab

You are able to start Sapera CamExpert but you do not see an image and the frame rate displayed 15 0.
+  Verify power is connected to the camera.
+*  Venfy the camera and timing parameters with the camera 1n free run mode.
+ Venfy you can grab with the camera in free run mode.

+  Make certain that you provide an external trigger if the camera configuration file requires one.
Use the software trigger feature of CamExpert if you do not have a trigger source.

+  Make certain that the camera is properly connected to the cable.

+  Make certain that the camera is configured for the proper mode of operation. This must match
the camera configuration file. Refer to your camera datasheet.

+* Try to snap one frame instead of continuous grab.
*  Perform all installation checks described in this section before contacting Technical Support.

Symptoms: Card grabs black

You are able to use Sapera CamExpert, the displaved frame rate is as expected. but the display 1s always
black.

*  Set your camera to manual exposure mode and set the exposure to a longer period. plus open the
lens iris.

* Try to snap one frame instead of continuous grab.
+  Make certamn that the mput LUT is not programmed to output all “0’s.

+  This problem is sometimes caused by a PCle transfer 1ssue. No PCle transfer takes place. so the
frame rate 1s above 0 but nevertheless no image 1s displaved in CamExpert.

+ Nake certain that BUS MASTER bit i the PCle configuration space 1s activated. Look in PCI
Diagnostics for BM button under “Command™ group. Make certain that the BM button s
activated.

+  Perform all mstallation checks described in this section before contacting Technical Support.

MR oINS d—g 1 I 17
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X64 Xcelera-CL PX4 D' Grab L7E0))

ERAS
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CamExpert TERISERT LN, RSSNEERT —INRNEZDHEE.

RN

DAASAVYZaAPIEHRE—RAKRELETYT, ZLUTCLUYXEZEHM U TCENERVFEANERELET,

QB IS TNSERT Y TVay fNIDEBZZFT,

Q1Y TYyFLUTHAETPORT Y k=)L “O” ATATSASNTVRNDERLET,

@D DREBENTFRPCle xR ES IR LE T, PCle [FBAZE> TVEBA. > T
JU—AU—FEOMLETT,. LALZNICENDNDSTF CamExpe r t TEHENRIZSNEE A,
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Symptoms: Card acquisition bandwidth is less than expected

The X64 Xcelera-CL PX4 acquisition bandwidth is less than expected.
+* Review the system for problems or conflicts with other expansion boards or drivers.

* Remove other PCI Express, PCI-32 or PCI-64 boards and check acquisition bandwidth again.
engineering has seen this case where other PCI boards 1in some systems cause himitations in
transfers. Each system, with 1ts combination of system motherboard and PCI boards, will be
unique and will need to be tested for bandwidth limstations affecting the imagmg application.

*  Is the X64 Xcelera-CL PX4 mstalled in a PCT Express x16 slot?
Note that some computer's x16 slot may only support non x16 boards at x1 or not at all. Check
the computer documentation or test an X64 Xcelera-CL PX4 mstallation Note that the X64
Kcelera-CL PX4 board 1s not designed to function at x1 speeds. The speed at which the board 15
runming at 1s logged 1n the LogViewer. Check for an entry sinular to this:
“___X64 FPGA_GetPciSpeed =x8...”

EEARIN—2)
BRS7)— ROEBIEOEIE K DL

ERAS
DOEBEDY AT AFXEIFMDILRN— FEEEM—FELE2 - LET,
@D PCI Express, PCI-32 &F/2[3 PCI-64 R— FZEDS L, ZLTHE, BSHEIBZHR LI T,
@X64 Xcelera-CL PX4 (& PCI Express x16 20w A Y2 ~—)LNZFELEH?
IR CEDHNOIVEI—-IDx1 TIHx16 ROvY FEYR—FIIBETHEEE. ETUENEIC
SERNMETY,
IVE2A—FDRFaXYFT—Y3VEEIE X64 Xeelera-CLPX4 ¥ YA LU —Y3VYF R EEFT v I UET,
X64 Xcelera-CL PX4 1h— R x1 ZE— FOMEENT T+ Y ESNBNBITERLUTUVTEUY,
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Connector and Switch Locations

X064 Xcelera-CL PX4 Board Layout Drawing

J2

D1

J3

Connector, Switch, Jumper Description List

The following table lists components on the X64 Xcelera-CL PX4 board.

= L

X664 Xcelera-CL PX4

PCle X4

o W . B - O O .
D4 D5
UBE) sw % SW2 —=

J3

J10

for connectors or switches the end user may have need of.

Detailed information follows

Location Description Location Description
]2 Camera Link Connector J6 X-1I/O Module Interface
I3 Camera Link Connector J7 PC power to camera interface.
J4 External Signals connector J1. 18, Reserved
J10, 12000
Jo Multi Board Sync SW1,SW2, SW3 | Configuration micro-switches
D1 Camera/PCle status LEDs D4.D5 Boot-up Status LEDs (refer to text)
N=FFSIONLYa =517

20
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Connector and Switch Specifications

X64 Xcelera-CL PX4 End Bracket Detail

X64 Xcelera-CL PX4

()

=1 [=100

L Camera Link 1 T Camera Link 2
3M MDR 26 pin female LEDs  3M MDR 26 pin female
connector connector

The hardware mnstallation process 1s completed with the connection of a supported camera to the X64
Xcelera-CL PX4 board using Camera Link cables (see “Camera Link Cables™ on page 107).

s  The X64 Xcelera-CL PX4 board supports a camera with one or two Camera Link MDR-26
connectors (two Base or one Medium — see “Data Port Summary™ on page 106 for information
on Camera Link configurations).

s  Connect the camera to the J1 connector with a Camera Link cable. When using a Medium
camera, connect the second camera connector to J2.

Note: If the camera 15 powered by the X64 Xcelera-CL PX4. refer to "External Signals Connector Bracket
Assembly"” on page 99 for power connections.

Contact Teledyne DALSA or browse our web site www teledynedalsa com/mv/support_for the latest
information on X64 Xcelera-CL PX4 supported cameras.
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Configuration Micro-switches

Three sets of 4 switches are used for user configurations not controlled by software. The following figure
1s a typical view of each switch set. shown with the individual switch set in the OFF position. Following
the figure. each of the three switch sets 1s described. Refer to the board component layout for their
positions.

ON
OFF

1 2 3 4

SWI1. SW2 SW3 Component View

SW1: General Inputs Signal Switch Point

For each general input. select the threshold voltage detected as a logic hugh signal See "Note 1- General
Inputs Specifications” on page 94.

SW1 Assigned to OFF Position ON Position
Switch Number (default)
. 8 1_.tq:|ul T Logic Transition at
2 general input 2 ~2 volts Logic Transition at
3 general input 3 (preferred for differential ~10 volts
: signals)
4 general input 4

SW2: Trigger Inputs Signal Switch Point

For each trigger mput, select the threshold voltage detected as a logic lugh signal. See "Note 3: External
Trigger Input Specifications” on page 95.

SW2 Assigned to OFF Position ON Position
Switch Number (default)
! Rigzeringd | Logic Transition at
2 trigger input 2 ~2 volts Logic Transition at
3 NA (preferred for differential 10 volts
4 NA signals)
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SW3: Normal/Safe Boot Mode & GEN2 Slot Workaround

The X64 Xcelera-CL PX4 powers up either in 1ts normal state or a 'Safe Boot' mode requared to load
firmware under certam conditions. See the notes for SW3-1 following the table for details.

SW3 Assigned to OFF Position ON Position
Switch Number (default)
1 Boot Mode Mormal Safe
2 GEN2 Slot Workaround Dhsable (default) Active
3 reserved
4 reserved

SW3-1 Boot Mode Details

Normal Mode: Board powers up m the normal operating mode.

Safe Mode: With the computer off. move the switch to the ON position. This mode 1s required if any
problems occurred while updating firmware. With the switch 1n the ON posttion, power on the
computer and update the firmware again. When the update 1s complete, power off the computer and
move the switch to the OFF position. Power on the computer once again for normal operation. (See
"Recovenng from a Firmware Update Error” on page 31).

SW3-2 GEN2 Slot Workaround Details

Normal Mode: Normal operation of the Xcelera-CL PX4.

GEN2 Slot Workaround: In computers with GEN2 slots and the Intel 5400 chipset. there have been

circumstances where the board 15 not detected properly. This 1ssue 15 identified by the status LED 2

that keeps on flashing red at boot tiume. In one example, with a Dell T5400 or T7400 computer. the

following message was displayed by the computer BIOS:

"Alert! Error initializing PCI Express slot™.

* Therefore when using such a computer. with the Xcelera SW3-2 in the ON position, the
computer should boot normally and the Xcelera should function. If this 1s not the case. please
contact "Technical Support” on page 124 with details about your computer.

* Note: ECO 4251 15 needed for SW3-2 to be functional.
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Device Manager MO R ElH)

JU—ADSNN—=%Z@—PCRIC2KWMU L. RELEBSICITS
Teledyne Dalsa Device Manager (DIE{EZLTE

THE, B—PCRIC2KUEDTIU—LATS/I\N—EREUEID
Device Manager ODRRNBE CI,

File Help

Firmware Update Manager

tart Update | Save Config file l Load Canfig File l < iv Same Configuration For &l Device§>

Device | Field | Value
=7 =1 rial Mumber 53807057
Update Firmware Devic Fi0n B2
PCI-64 Interface 1.50.00.0603
PCI-32 Interface 1.50.00.0603
ACU/DTE Firmware 1.50.00.0603
onfiguration 2 % Basze Cameralink [Flat Field Correction)
nformation Support for bwo independant Base Cameralink ports with Flat Field Comrection. Flat Fi
Firmsare State Update Mot Required
#64-CL_jPro 2 Serial Number 53507092
Update Firmware DeviceYersion B2
PCI-64 Interface 1.50.00.0603
PCI-32 Interface 1.50.00.0603
ACU/DTE Firmware 1.50.00.0603
I Firmsare State Update Mot Required
|
|
Device Info Firmware Upda.. |
Output

[15:28:43] [(%64-CL_iPro_2] - Update of PCI-64 Interface in progress... -
[15:28:43] [<E64-CL_iPro_Z2] - Firmware iz up to date.

[15:28:43] [<E64-CL_iPro_2] - Update of PCI-32 Interface in progress...
[15:28:43] [<E64-CL_iPro_2] - Firmware iz up to date.

[15:28:43] [<B4-CL_iPra_2] - Update of ACU/DTE Firmware in progress. .. )
[15:28:44] [<64-CL_iPra_2] - Firmware iz up to date. |
[15:28:44] [<B4-CL_iPro_2] - Device's firmware iz already up to date. =
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TJL—LYS5SN\N—%FB—PCHIZ2HLULE, EXLE-BEDIER)

FEOERIC PC D PCI-X /NN Teledyne-Dalsa DU —ADS/IN—%&
220D Slot N\ 2 MR LU THEET DT DIHS. Firmware Updater Z L&D
BRICERELE T,

C D, MDevicel WICHDT /N1 RE_BSTEHRIIND,
Update Fitmware [CF T v OV =20 A > TUVENBE.
Firmware Update ODETZETNEE A,

2 MEIFIC Firmware Update Z2ME9 21%5. LD Updater Firmware A\
FTwOV—DO%FAN. StartUpdate] 201 v D3FBDE. ZNBNDT/NA ZN
Firmware Update 'S5 9.,

X ZDBF. Device Driver Z18/X—3 3 > ® Device Driver D'S&HD
Device Driver N\Z&E UZIHES. PC SRZRELUIZIR. BENIC
Firmware Updater D8 g 3N H D KT,

Firmware Update D'EBICIR T UIZIBS. RED PC EE#IFH 53,
Firmware Update [FEE LENKDICEDFT,

(CCTIE. Teledyne-Dalsa Device Manager DWERICT/ N1 2 & 5058
LTNBUEBHHNZET.
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